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What is STEM?

STEM stands for Science, Technology, Engineering and 
Mathematics

The aim of STEM is the integration of these four disciplines 
together in teaching and learning. As, in the real world, these 
four disciplines rely heavily and seamlessly on each other.

STEM helps strengthen key life skills such as analytical thinking, 
problem solving, creativity, teamwork and technical skills
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What is WiTT?

WiTT stands for Women in Technology and Trades

WiTT is a group that increases opportunities and support for 
women in technology and trades in all fields, through a rich 
networking and support community

WiTT welcomes industry, staff, students and faculty across all 
areas of the college and all genders, backgrounds, races and 
orientation to become involved and contribute to the support of 
women in technology and/or trades.
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Introduction



WiTT STEM Kit 
Smart Watch Kit
This kit will give students a hands-on experience with STEM, with a focus on the 
Technology and Engineering aspects. With this kit, students will learn:

• What each hardware component is, and how they work.
• How 3D printing works and using software to create their own watch 

case.
• How to code basic watch functions using Arduino IDE.
• How to construct and solder circuits.

From coding watch functions to assembling the watch, students will receive firsthand 
experience with STEM. Students will come out with their very own basic smart watch 
that can be continuously experimented with to bring more functionality!
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Curriculum Points
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Grade 10, Open. Page 58. Part A. Computer Technology Fundamentals. Subpart A1. Computer Hardware. Section A.1.3 
Identifying the basic components and peripheral devices of a computer system.

Grade 10, Open. Page 59. Part B. Computer Technology Skills. Subpart B1. Workstation Setup. Section B1.3 Using file-management 
techniques to organize and back up files. Subpart B2. Electronics, Robotics, and Computer Interfacing. Section B2.1 Safely construct and test 
electronic circuits using both breadboard and soldering techniques to connect discrete components and/or integrated circuits. Subpart B4. 
Software. Section B4.2 Installing and configuring software on a workstation.

Grade 10, Open. Page 60. Part B. Computer Technology Skills. Subpart B5. Computer Programming. Section B5.1 Using a procedural 
programming language to define constants and variables, write expressions and assignment statements, and specify the order in which the 
operations are performed in a program. Section B5.2 Using input and output statements in a program.

Grade 10, Open. Page 36. Part B. Introduction to programming. Subpart B1. Programming concepts. Section B1.5 
Identifying situations in which decision and looping structures are required. Subpart B2. Writing Programs. Section B2.5 
writing programs that use looping structures effectively.

Grade 11, University Preparation. Page 40. Part A. Programming Concepts and Skills. Subpart A3. Subprograms. Section 
A3.2 Writing subprograms that use parameter passing and appropriate variable scope, to perform tasks within programs.

Grade 11, College Preparation. Page 48. Part A. Programming Concepts and Skills. Subpart A1. Data types and 
Expressions. Section A1.2 Demonstrate the ability to manipulate string data in a computer program. Section A1.3 Using 
assignment statements correctly with both arithmetic and string expressions in computer programs.

Grade 12, University Preparation. Page 56. Part A. Programming Concepts and Skills. Subpart A3. Designing algorithms. 
Section A3.1 Demonstrate the ability to read from, and write to, an external file.

Grade 12, College Preparation. Page 66. Part B. Software Development. Subpart B3. Graphical user interfaces. Section 
B3.1 Designing graphical user interfaces that contain common controls.



Smart Watch Kit
Kit Requirements
1. Small SPDT Switch

2. TP4056 Charging Board

3. Waveshare 1.54inch E-Ink Raw Display Panel

4. Waveshare e-Paper ESP32 Driver Board

5. 3.7V 600mah Lithium-ion Polymer Battery

6. Velcro Wrist Strap

7. Mini Micro Jst 2.0 Ph 2-Pin Connector Male Plug

8. Jumper Wires

9. Micro USB to USB Cable

10. 3D Printer

11. Soldering Iron

12. Arduino IDE
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Microcontroller

A microcontroller is a compact 
integrated circuit designed to 
control a specific operation in an 
embedded system (a 
combination of computer hardware 
and software designed for a 
specific function or functions). A 
typical microcontroller includes a 
processor, memory and 
input/output (I/O) peripherals on a 
single chip.

Microcontroller Board
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Microcontroller Board

SPI

A Serial Peripheral Interface (SPI) is 
an interface bus commonly used to 
send data between microcontrollers 
and peripherals.

Micro USB Port

A micro Universal Serial Bus (USB) 
port is a standard cable connection 
interface for personal computers and 
consumer electronics devices.
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Microcontroller Board

USB to UART Bridge

A Universal Serial Bus (USB) to 
Universal Asynchronous 
Receiver/Transmitter (UART) allows 
UBS connectivity to a device with a 
UART interface such as a 
microcontroller.

I/O Connectors

Input/output connectors are an 
electrical contact that allows data 
transmission to external devices.
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Display Panel

E-Ink Display
Electronic Ink displays are used 
to mimic the appearance and 
reflect light like pen on paper.

These displays work by taking 
thousands of capsules only 100 
microns wide filled with pigment 
chips and suspending them in a 
liquid polymer. When an 
electronic charge is applied to 
the capsules, the pigment chips 
will either be pushed to the top 
where they appear white or 
pulled to the bottom where they 
appear black.
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Charging Board

TP4056 Chip
The TP4056 is a chip used to charge single cell 
lithium-ion polymer battery. This chip allows the 
battery to charge at a constant current/voltage, 
with built-in protections to stop the battery from 
over charging (which would damage it), as well 
as a trickle charge threshold which prevents the 
battery from outputting a low voltage while in 
use that could damage the board it is powering.

Rprog

The programming resistor 
(Rprog/R3) is a resistor set to 1200 
ohms which allows the battery to 
charge at a 1-amp charge rate.
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Charging Board

DW01A Protector Chip
The DW01A chip provides short circuit 
protection by monitoring the charger input 
with short circuit, over current, charger, and 
reverse charger detectors. It also monitors 
the battery with an overcharge detector 
(battery voltage is too high) and 
overdischarge detector (battery voltage is 
too low).
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Charging Board

8205A Duel MOSFET
A duel Metal Oxide Semiconductor Field 
Effect Transistor (MOFSET) is a chip made 
up of 2 MOSFETs in series. These transistors 
are made up by 3 pins – the gate, the 
drain, and the source that work as a 
variable resistor controlled by voltage. 
When voltage is applied to the gate and the 
source, current can flow from the drain to 
the source. The current is variable 
depending on the voltage applied to the 
gate. In this case the duel MOSFET is used 
to limit the current flowing into the battery, 
stopping the battery from charging once it 
reaches its max voltage.
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Charging Board

Voltage In Plated-Through 
Holes
Voltage in plated-through holes allows you 
to connect to another voltage source to 
charge the battery instead of using the 
micro USB port. The plus end connects to 
the positive end of the voltage source, while 
the negative connected to the ground.

Voltage Out Plated-Through 
Holes
Voltage out plated-through holes allows you 
to power a component with the lithium-ion 
polymer battery. The plus end is connected to 
the positive end of the voltage in on the 
component, while negative end is connected 
to the ground.
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Charging Board

Battery Plated-Through 
Holes

The battery plated-through 
holes are the points where the 
board connects to the battery. 
The plus connects to the 
positive end of the battery, 
while negative connects to the 
negative end of the battery.

Smart Watch Kit

➢ Introduction
➢ Kit Requirements

➢Hardware
➢ 3D Printing
➢ Coding
➢ Watch Assembly

11.

12.



17

Time to Reflect!
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1. What other hardware components do you think you could 
add?

2. What are some electronics that would use these 
components?
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Computer Aided Design (CAD)

3D Modeling
Models are created in a 3-
dimensional space where they 
are made up of 2-dimensional 
surfaces known as a "plane".

Various shapes can be 
sketched on these planes for 
example lines, circles, squares, 
and ellipses.
These sketches can be 
modified by doing actions such 
as extruded, cut out, revolved, 
lofted, and many more.

Great for 
beginners!

Wide range of free software 
available for students, ranging 
in levels of expertise. 14,15.
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Slicing and File Formats

First the 3D model will be 
saved as a 3D object file. 
This object must be "sliced" 
before it can be printed, and 
the slicer software requires a 
specific format known as 
Standard Triangle Language 
(.STL)

"Slicing" is a computer-
generated process that 
takes an .STL model and 
converts it into code that 
the 3D printer can read; 
.GCODE
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.GCODE breaks the file 
down into individual layers 
and movements for the 
printer to read. This code 
can be hundreds of pages 
long for complex prints!

16. 17.
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Fused Deposition Modeling (FDM)
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3D Printing
FDM printing works by heating 
a plastic filament to its melting 
temperature and then 
extruding the molten plastic 
through a fine nozzle.

This process repeats, layer 
by layer, until the part is 
fully created.

Sometimes support 
material must be used for 
hallow parts and can be 
easily removed after.

18. 14.



Smart Watch Kit

➢ Introduction
➢ Kit Requirements
➢ Hardware

➢3D Printing
➢ Coding
➢ Watch Assembly

Case Model

22
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Time to Reflect!
Smart Watch Kit

3. What revisions would you make to the current case design?

4. What are the advantages to using 3D printing to create a 
case?
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Coding

Let's you communicate with 
a computer using a 
programming language to 
give it instructions on what 
to do.

There are hundreds of types 
of programming languages, 
but some of the most 
commonly used are C++, 
JAVA, C#, Python and Ruby.

These programming 
languages can be written 
with a type of 
software called IDE 
(Integrated Development 
Environment).

19.

20.
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Arduino

Arduino IDE
The Arduino IDE is an open-
sourced software based in 
C/C++ that makes it easy to 
write code and upload it to the 
board.

Sketches
A sketch is the name that 
Arduino uses for a program. 
It's the unit of code that is 
uploaded to and ran on the 
board.

Libraries
Libraries are files written in 
C or C++ which provide 
your sketches with extra 
functionality. This project 
will require the addition of 
different libraries.

21.

22.
23.
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Installing Board and Library Files

Installing and Setting up the Board
1. Open the Arduino IDE. Go to the Tools drop-down menu, then go down to Board, 

and then select Boards Manager.

2. In the Boards Manager window, search for ESP32, then select install. ➢ Introduction
➢ Kit Requirements
➢ Hardware
➢ 3D Printing

➢Coding
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Installing Board and Library Files
3. Go to the Tools drop-down menu, go down to Board, then to ESP32 Arduino and 

select the ESP32 Dev Module.
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Installing Board and Library Files
4. Plug in the board to your computer using the USB to micro USB cable.

5. Open the start menu on your PC and type in device manager, then hit enter.

6. In Device Manager go down Ports(COM & LPT) and hit the little arrow next to it to 
see all the serial ports. There you will see a port named Silicon Labs CP210X USB 
to UART Bridge. Look at the brackets to see what COM port number it is connected 
to.
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Installing Board and Library Files

7. In the Arduino IDE, go to the Tools drop-down menu, go down to Ports, then select 
the appropriate serial port.
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The board is now ready to be used with the Arduino IDE!
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Installing Libraries

1. Download the E-Paper ESP32 Driver Board Code.

2. Extract the files from E-Paper_ESP32_Driver_Board_Code.

3. Open the E-Paper_ESP32_Driver_Board_Code extracted folder, then open the 
examples folder.

4. Make a .zip file of esp32-waveshare-epd folder.
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https://www.waveshare.com/w/upload/5/50/E-Paper_ESP32_Driver_Board_Code.7z
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Installing Board and Library Files

5. Open the Arduino IDE, go to the Sketch drop down menu, then go down to Include 
Library, from there select Add .ZIP Library.

6. In the file explorer, go to the file location where you created the .zip of the esp32-
waveshare-epd folder and select it.
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Smart Watch Kit
Installing Board and Library Files

7. Download the minigrafx, Time, ESP32 e-Paper Weather Display, Adafruit GFX, GxEPD2 and ArduinoJson
libraries.

8. Open the Arduino IDE, go to the Sketch drop down menu, then go down to Include Library, from there 
select Add .ZIP Library.

9. In the file explorer, go to your downloads and select one of the .zip file of the libraries you just 
downloaded. Do this for each of the 6 libraries.
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The libraries are now installed, and you are ready to start coding!

https://github.com/ThingPulse/minigrafx/archive/master.zip
https://github.com/PaulStoffregen/Time/archive/master.zip
https://github.com/G6EJD/ESP32-e-Paper-Weather-Display/archive/master.zip
https://github.com/adafruit/Adafruit-GFX-Library/archive/master.zip
https://github.com/ZinggJM/GxEPD2/archive/master.zip
https://github.com/bblanchon/ArduinoJson/archive/6.x.zip
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Smart Watch Kit
Example Code

This project will include 3 example codes, Analog Watch, Watch with WIFI, and Weather. 
Analog Watch and Watch with WIFI will contain activities within them to complete the 
code, while Weather is a showcase of some of the more intricate projects you can 
create with this hardware and libraries. For more example codes, and to see more of 
the board's capabilities go to the File drop-down menu in the Arduino IDE, then down to 
Examples, from there you can see example codes for ESP32 Dev Module and the 
libraries you added.
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Code Functions

Function
A function is a set of 
statements that take 
inputs, do some specific 
computation and produces 
output.

Functions can be used to 
divide up your code into 
individual tasks. This makes 
it easier to troubleshoot 
your code as well as make it 
easier to read.

A function definition consists 
of a return type, function 
name, parameters, and 
function body.

➢ Introduction
➢ Kit Requirements
➢ Hardware
➢ 3D Printing

➢Coding
➢ Watch Assembly

25.

26.

27.

28.



36

Smart Watch Kit
Code Functions

A return type is the data type 
of the value the function 
returns. Ex. int, float, char etc. 
In cases where the desired 
function operation does not 
return a value, the keyword 
void is used.

A Function name is the 
actual name of the function. 
The function name will be used 
to call the function in the main 
routine.

Parameters are used as 
placeholders for the data going 
into a function. When a function 
is used, you pass a value to the 
parameter. The parameter list 
refers to the type, order, and 
number of the parameters of a 
function. Parameters are 
optional, a function may contain 
no parameters.

The Function body contains a 
collection of statements that 
define what the function does.
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Smart Watch Kit
Code Functions

Library Functions
Library functions are built-in functions in the libraries that only need to be called 
upon to be used. Here’s a list of the functions in the libraries used in our example 
code, and how a they work:
Initialization and screen clearing

DEV_Module_Init(); - This tells the board what pins are being used by the e-paper display. 
It also sets the data rate in bit per second for serial data transmission.

EPD_1IN54_V2_Init(); - This initializes the e-paper register, which holds values of internal 
operations, such as the address of the instruction being executed, and the data being 
processed.

EPD_1IN54_V2_Clear(); - This clears any data left on the e-paper display.

EPD_1IN54_Display(ImageName); - This sends image buffer in the boards RAM to the e-
paper display.

DEV_Delay_ms(milliseconds); - This is used to suspend execution of a program for a 
particular time.
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Smart Watch Kit
Code Functions
Paint_NewImage(ImageName, Width, Height, Rotation, Colour); - This takes 
an image in the cache and displays it on the screen. Width and height can be set 
between 1-200 pixels. Rotation can be set as 0, 90, 180, and 270 degrees. Colour 
can be set as BLACK or WHITE depending on background colour you would like.

Paint_SelectImage(ImageName); - This allows you to select an image from the 
cache.

Paint_Clear(Colour); - This clears the display setting it to all white or all black, 
using WHITE or BLACK in the brackets.

Paint_ClearWindows(X Start, Y Start, X End, Y End, Colour); - This clears a 
specific part of the display. X and Y start, are the starting coordinates. X and Y end 
are the end coordinates. Everything between those point will clear to the set colour 
(WHITE or BLACK).
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Smart Watch Kit
Code Functions
Displaying Strings

Parameters for using the print strings functions are 
(X, Y, ”__ ”, &Font, Font colour, Background colour);

• X and Y are the coordinates of where on the display you want the number/string printed. For both X 
and Y, the number can be between 1-200, as the screen is 200 x 200 pixels.

• In the quotation marks goes the number/string you want to print. If you wanted to print a variable, 
you would need to do (”%d”, variableName) for int variable and (”%s”, variableName) for a string 
variable, instead of the quotation marks.

• &Font can be set as &Font8, &Font12, &Font16, &Font20, or &Font24 depending on the size of font 
you would like.

• Font colour can be set as WHITE or BLACK, the same goes for background colour.

Paint_DrawString_EN(X, Y, “__”, &Font, Font colour, Background colour); - This function will 
print a string.

Paint_DrawNum(X, Y, “__”, &Font, Font colour, Background colour); - This function will print a 
number.
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Smart Watch Kit
Code Functions
Displaying Time

If you want to print the time on the display you will first need to declare PAINT_TIME 
sPaint_time;. PAINT_TIME is a structure. A structure is a collection of variables (can be of 
different types) under a single name. In this case PAINT_TIME is used to define time 
attributes, i.e. hours, minutes, and seconds. sPaint_time is a preset variable to used to access 
the structure.

To access the variables in the structure you will need to use sPaint_time.Hour, 
sPaint_time.Min, and sPaint_time.Sec.

Paint_DrawTime(X, Y, &sPaint_time, &Font, Font colour, Background colour); - This 
function will print the time on the display.
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Code Functions

Displaying Shapes

Paint_DrawPoint(X, Y, Colour, Point size, DOT_STYLE_DFT); - This function will print a 
point. Point size can be adjusted by using DOT_PIXEL_1X1, DOT_PIXEL_2X2, 
DOT_PIXEL_3X3, etc. all the way up to 8X8.

Paint_DrawLine(X Start, Y Start, X End, Y End, Colour, Point size, Line style); - This 
function will print a line from the starting coordinates to the end coordinates. There are 2 
different line styles for this function. The first being LINE_STYLE_SOLID, which will print a 
solid line. The second being LINE_STYLE_DOTTED which will print a dotted line.
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Code Functions

Paint_DrawRectangle(X Start, Y Start, X End, Y End, Colour, Point size, Fill style); -
This function will print a rectangle from the starting coordinates on the top left, to the end 
coordinates on the bottom right There are 2 different fill styles. The first being 
DRAW_FILL_EMPTY, which will leave the rectangle empty. The second being DRAW_FILL_FULL 
which will completely fill in the rectangle black.

Paint_DrawLine(X , Y , Radius, Colour, Point size, Fill style); - This function will print a 
circle, with X and Y being the centre point.
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Smart Watch Kit
Startup Image

Follow these steps if you like to change the startup image that displays when the 
watch boots up.

1. Find an image. Try pick a simple image with little colour variation as it will lose 
details once it is converted to black and white. The image must also be upside 
down so that when it is uploaded to the watch it is displayed in the correct 
orientation. Also make sure the image is one these formats -
.gif/.jpg/.jpeg/.png.

2. Convert the image in a hex code array. This website will do the conversion for 
you. Make sure you have the following settings before you click Get C string. Code 
format is set to HEX:0x, Resize to is set to Width 200, Height 200, and that Used 
for is set to Black/White. For “DIM”.
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https://www.digole.com/tools/PicturetoC_Hex_converter.php
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Smart Watch Kit
Startup Image

3. Copy all the hex code from the Image data box.

4. Open the either the Analog Watch code or Watch with WIFI (which ever one you 
like to modify). Once it is open, go to the ImageData.c tab.
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Smart Watch Kit
Startup Image

5. Highlight and delete all the hex code between const unsigned char startup[5000] 
= { and };.

6. Take the hex code you copied from the image data box on the website and paste 
it between the curly brackets. Upload the code to the board and you should see 
your new startup image!
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Troubleshooting
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Here are solutions to commonly ran into issues while compiling the code:

1. No such file or directory Error. This is due to a library being missing. When the error 
appears, it will highlight the missing libraries .h file in the includes section. Once you know 
what library is missing, simply go to include library under the sketch menu, and add that 
libraries .zip file. 

To make sure you have all the libraries installed go to your documents folder on you PC, then 
to Arduino, then to Libraries (C:\Users\user\Documents\Arduino\libraries), and make sure all 
7 libraries are there from slides 31 and 32.



47

Smart Watch Kit
Troubleshooting

➢ Introduction
➢ Kit Requirements
➢ Hardware
➢ 3D Printing

➢Coding
➢ Watch Assembly

2. Error compiling for board ESP32 DEV Module. Fatal error: Adafruit_12CDevice.h: 
no such file or directory. This is due to the IDE trying to read 2 files in the Adafruit GFX 
library meant for OLED displays. 

To fix this, go to your documents folder on you PC, then to Arduino, then to Libraries, then to 
Adafruit-GFX-Libraray Master (C:\Users\user\Documents\Arduino\libraries\Adafruit-GFX-
Library-master). Once there, delete both Adafruit_MonoOLED files.
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3. A fatal error occurred: Failed to connect to ESP32: Timed out waiting for packet 
header. This is due to the IDE not being able to connect to the board. 

To get around this bug, when the code is compiled, and you see Connecting… in the console, 
hold the boot button on the driver board until you see the code is being written to the board 
on the console.
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5. What other functionality could you add to the watch?

6. How could you integrate this code into other projects?
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Watch Assembly

Wiring the TP4056 Charging Board

To begin wiring the TP4056 board we will start by soldering the Mini Micro Jst 2.0 
Ph 2-Pin Connector Male Plug to the battery plated-through holes on the board. To 
match the polarity on the battery, make sure to solder the red wire to the positive 
hole, and the black wire to the negative hole.
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Next, we will solder a small wire with both end stripped to the voltage out positive 
plated-through hole.
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Next, we will solder a jumper wire with a female header housing on the end to the 
voltage out negative plated-through hole.
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Once the jumper wire is soldered to the negative end of the voltage out, we will 
then solder the stripped end of the wire connected to the positive end voltage out to 
the outer pin of the SPDT switch.
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Watch Assembly

Next, we will solder a jumper wire with a female header housing to the middle pin of 
the SPDT switch. Once it is soldered to prevent any short circuits, wrap electrical 
tape around the switch pins.
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Assembling Components into Watch Case

To begin assembling all the components into the case, we’ll start by placing in the 
battery. Apply double sided tape to one side of the battery to help keep it secure 
and place it in the center of the case.
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After placing the battery we will connect our charging circuit. Make sure power the 
is switched off, also that the polarities match to prevent damage to the board and 
battery! The switch off position is the side opposite to the pin connected to the 
positive voltage out. For the polarities make sure that red is connected to red, and 
black is connected to black.
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Once the battery is connected to the board, take the switch and insert through the 
cut out. Once the switch is in place, apply a small piece of double-sided tape to the 
bottom of the board. Next, place the board on the battery making sure that the 
micro UBS port aligns with the cut out.
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Next, we will connect the SPI extension header to the board. After it is connected, 
tuck and fold the excess ribbon underneath the board and use small elastic bands to 
hold it in place. This will make it easier to put the board in the case.
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Now we will connect the charging board to the driver board. We will first take the 
jumper wire connected to negative voltage out and plug it into the IO pin labeled 
GND on the bottom of the board. Next, we will plug in the jumper wire connected to 
the switch to the IO pin labeled 5V. Make sure these wires are plugged into the 
correct IO pins to prevent damaged to both boards.
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Once the driver board is connected to the charging board, lower the driver board 
into the case, making sure that the micro USB port lines up with the cut out.
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Next, apply double-sided tape around the edges of the screen cut out on the top 
plate. After applying the tape, line up the screen with the cut out and press it into 
place.
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Now connect the e-paper screen to the extension header. After, take the top plate 
and click it into place on the case, making sure the cut outs line up with the buttons 
on the board.
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For the final step, take the Velcro strap and thread it through the slits on the bottom 
of the case.

You have now completed your watch!
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POWER FROM THE BATTERY 
MUST BE SWITCHED OFF BEFORE 

CONNECTING THE ASSEMBLED 
WATCH TO A COMPUTER!

WARNING

HAVING POWER FROM BOTH THE USB PORT AND BATTERY COULD RESULT IN DAMAGE TO 
THE BOARD, BATTERY, AND YOUR COMPUTER!
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7. Did you encounter any struggles while assembling the watch? 
If so, how did you overcome them?

8. What are some of the skills you used in this project that you 
would like to work to improve?
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